
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Common-Controls 
Aufsetzen einer Java 
Entwicklungsumgebung 
für MS Windows 
 
 
 
 
 
 
 
Version 1.6 - Stand: 14. Januar 2006 

 
 
 

  
 



Einrichten einer Entwicklungsumgebung  
 

 
Quickstart ii 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Herausgeber: 
SCC Informationssysteme GmbH 
64367 Mühltal 
 
Tel: +49 (0) 6151 / 13 6 31 12 
Internet http://www.scc-gmbh.com 
 
 
Product Site: 
http://www.common-controls.com 
 
 
Copyright © 2000 - 2006 SCC Informationssysteme GmbH. 
All rights reserved. Published 2003 
 
No part of this publication may be stored in a retrieval system, transmitted, or reproduced in any way 
without the prior agreement and written permission of SCC Informationssysteme GmbH. 
 
 
 
Sun, Sun Mircosystems, the Sun Logo, Java, JavaServer Pages are registered trademarks of Sun 
Microsystems Inc in the U.S.A. and other Countries. 

Microsoft, Microsoft Windows or other Microsoft Produkte are a registered trademark of Microsoft 
Corporation in the U.S.A. and other Countries. 

Netscape, Netscape Navigator is a registered trademark of Netscape Communications Corp in the U.S.A. 
and other Countries. 
 
All other product names, marks, logos, and symbols may be trademarks or registered trademarks of their 
respective owners. 
 
 



Einrichten einer Entwicklungsumgebung  
 

 
Quickstart iii 
 

 

Inhaltsverzeichnis 
1 Installation...............................................................................................................................................1 
1.1 Installation des Sun JDK ......................................................................................................................1 
1.2 Installation des Tomcat Application Servers ........................................................................................3 
1.3 Installation der Eclipse Entwicklungsumgebung ..................................................................................8 
1.4 Installation des Tomcat Plugin ...........................................................................................................10 
1.5 Konfiguration ......................................................................................................................................12 
1.6 Test der Installation: ...........................................................................................................................19 

2 Installation der Common-Controls Demo Anwendung ....................................................................22 

3 Debugging.............................................................................................................................................30 

4 JSP Compiler ........................................................................................................................................32 

 
 



Einrichten einer Entwicklungsumgebung  
 

 
Installation 1 
 

1 Installation 
Grundsätzlich kann eine Common-Controls Anwendung mit jeder beliebigen Java Entwicklungsumgebung 
erstellt werden. 
Auf der Companion CD befindet sich die folgende Lizenzkosten freie Software 
 

• Sun JDK (Java Development Kit) 1.5.0_04 (J2SE5) 
• Eclipse Entwicklungsumgebung Version 3.1 

mit zusätzlichen Plugins 
• Apache Tomcat 5.5.9 Application Server 

 

1.1 Installation des Sun JDK 
Common-Controls ist auf einem JDK >= 1.3 lauffähig. Die Wahl des JDK sollte sich nach der späteren 
Produktions Umgebung richten, damit Überraschungen beim Deployment der Anwendung vermieden 
werden. Wir setzen hier das neueste JDK von SUN in der Version 1.5.0_04 ein. 
 
ACHTUNG: Auf einigen Rechnern ist bereits ein Java JRE (Java Runtime Edition) installiert. Dieses reicht 
für die Entwicklung von Java Programmen nicht aus, da hier der Compiler fehlt. Es können aber ohne 
Probleme mehrere JDK’s und JRE’s auf einem Rechner parallel installiert werden. Die aktive Version wird 
die Environment Variable %JAVA_HOME% festgelegt. 
 
Bezugsquelle für das Sun JDK: 
http://java.sun.com/j2se/1.5.0/download.jsp 
 
Zur Installation des JDK wird einfach das Installationsprogramm auf der CD ausgeführt: 
[CD-DRIVE]\software\sun\jsdk 1.5.0\jdk-1_5_0_04-windows-i586-p.exe 
 

 
 
Während der Installation wird der JRE Wizard gestartet 
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Die erfolgreiche Installation kann mit dem „java –version“ Kommando überprüft werden: 
 

 
 

1.2 Installation des Tomcat Application Servers 
Der Tomcat Application Server ist die Referenz Implementierung für die Servlet Spezifikation von SUN. 
Alles was auf dem Tomcat läuft muss also auch auf jedem anderen Application Server laufen. 
Die Vorteile für die Entwicklung sind: 

• Sehr leichtgewichtiger Server mit erträglichen Startup Zeiten 
• Debugging der Anwendung direkt aus der Eclipse Umgebung 
• Kein Deployment der Anwendung notwendig die Anwendung läuft direkt in der Eclipse Umgebung 
• Keine Lizenzkosten 
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ACHTUNG: Tomcat kann als NT Service installiert werden. Dies ist jedoch für eine Entwicklungsmaschine 
aber eher ungünstig, da der Application Server hier immer aus der Eclipse Umgebung gestartet und 
angehalten werden soll. Er sollte daher nicht als Service installiert werden. 
 
Bezugsquelle für Apache Tomcat: 
http://jakarta.apache.org/site/downloads/downloads_tomcat-5.cgi 
 
Zur Installation des Tomcat wird einfach das Installationsprogramm auf der CD ausgeführt: 
[CD-DRIVE]\software\apache\tomcat\5.5\ jakarta-tomcat-5.5.9.exe 
 

 
 
Wählen Sie nun das Installationsverzeichnis aus 
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Legen Sie fest auf welchem Port der Application Server laufen soll und mit welchem Benutzer/Passwort die 
Administrations-Konsole geöffnet werden kann. 

 
 
Zuletzt wird das JDK angegeben mit welchem der Tomcat ausgeführt werden soll. 
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Test der erfolgreichen Installation: 
Öffnen Sie den Internet Explorer und geben sie die folgende URL ein: http://localhost:8080 
 
Sie sollten dann die folgende Seite sehen: 
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Halten Sie den Tomcat nun wieder an. Ein Klick das rechte Symbol in der Windows Statuszeile öffnet das 
Tomcat Status Fenster. Betätigen Sie hier die [Stop] Schaltfläche. 
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1.3 Installation der Eclipse Entwicklungsumgebung 
Eclipse ist eine sehr Leistungsstarke Lizenzkosten freie Entwicklungsumgebung, welche mit sehr großem 
Aufwand hauptsächlich von IBM entwickelt wurde und nun von der Eclipse Organisation (www.eclipse.org) 
weiterentwickelt wird. Die Entwicklungsumgebung ist für alle gängigen Betriebssysteme verfügbar und kann 
mit zahlreichen PlugIns erweitert werden. 
Man findet Sie zum Teil in kommerziellen Produkten (IBM WebSphere Application Developer oder 
MyEclipse). 
 
Bezugsquelle für Eclipse: 
http://www.eclipse.org 
 
Zur Installation von Eclipse wird einfach das ZIP Archiv nach c:\ entpackt: 
[CD-DRIVE]\software\eclipse\ eclipse-SDK-3.1-win32.zip 
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1.4 Installation des Tomcat Plugin 
Damit Eclipse mit Tomcat zusammenarbeiten kann muss noch das Tomcat Launcher Plugin installiert 
werden. 
 
Bezugsquelle für das Tomcat Launcher Plugin: 
http://www.sysdeo.com/eclipse/tomcatplugin 
 
Zur Installation des Tomcat Launcher Plugins wird einfach das ZIP Archiv nach C:\eclipse\plugins 
entpackt: 
[CD-DRIVE]\software\eclipse\plugins\Sysdeo\tomcatPluginV31beta.zip 
 

 
 
Das Sysdeo Plugin enthält wiederum ein PlugIn für den Tomcat Application Server. 
Entpacken Sie hierzu das Archiv 
C:\eclipse\plugins\com.sysdeo.eclipse.tomcat_3.1.0.beta\DevLoader.zip in das Verzeichnis 
C:\Program Files\Apache Software Foundation\Tomcat 5.5\server\classes 
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1.5 Konfiguration 

1.5.1 Eclipse starten 
Starten Sie nun die Eclipse Umgebung durch ein Doppelklick auf das eclipse.exe Icon 
 

 
 
Es erscheint der Start Bildschirm 
 

 
 
Es erfolgt die Auswahl des Arbeits-Verzeichnisses. Merken Sie sich dieses Verzeichnis für später, da hier 
Ihre Projekte abgelegt werden. 
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Eclipse ist gestartet 
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1.5.2 Java Version für die Entwicklung einstellen 
Öffnen Sie das Konfigurations Fenster über Window>Preferences.. 
 
 

 
 
Fügen Sie das vorhin installierte JDK 1.5.0_04 mit der [Add...] Schaltfläche hinzu: 
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Bestätigen Sie mit [OK] 
 
Machen Sie nun das JDK mit einem Klick auf die Checkbox zum Standard für die Entwicklung 
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Eclipse verwendet nun dieses JDK um die Klassen in einem Java Projekt zu compilieren. 
Bestätigen Sie alle Änderungen mit [OK]. 
 

1.5.3 Konfigurieration der Einstellungen des Sysdeo Plugins 
Öffnen Sie den Preferences Dialog erneut über Window>Preferences.. 

 
Legen Sie die Tomcat Version (5.x) und das Tomcat Verzeichnis (c:\Program Files\Apache Software 
foundation\Tomcat 5.5) fest: 
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Legen Sie des JDK fest, mit welchem der Tomcat gestartet werden soll: 
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Bestätigen Sie den Preferences Dialog mit [OK] 
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1.6 Test der Installation: 
Schliessen Sie das „Welcome“ Fenster. Sie sehen nun die Eclipse Oberfläche mit der Toolbar zum Starten 
des Tomcat Application Server 
 

 
 
Klicken Sie den „Tomcat starten“ Knopf. Nach einiger Zeit sollten Sie im „Console“ Fenster die folgende 
Meldung erhalten: 
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Wenn Sie nun wieder den Internet Explorer starten und http://localhost:8080 eingeben, dann Sehen sie den 
Tomcat Start Bildschirm 
 

 
 
Öffnen Sie in Eclipse mit Window>Open Perspective>Debug die Debug Perspektive. Sie sehen nun die 
aktiven Prozesse des laufenden Tomcat 
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Halten Sie nun den Tomcat Server mit der entsprechenden Schaltfläche in der Toolbar wieder an. Sie 
können den Prozess auch direkt in der Debug Sicht mit Hilfe des roten Quadrates terminieren. 
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2 Installation der Common-Controls Demo 
Anwendung 

Entpacken Sie das Common-Controls Samples Eclipse Projekt von 
[CD-DRIVE]\software\cc-samples\cc-samples-1.5.045 for Eclipse3.1.zip 
in das Workspace Verzeichnis welches Sie beim Start von Eclipse angegeben haben 
C:\Documents and Settings\[Windows User]\workspace 
 
Wechseln Sie nun in die Java Ansicht in der Eclipse Umgebung und wählen Sie aus dem Menü 
File>Import... 
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Eclipse importiert nun das Projekt in den Workspace und kompiliert das Projekt im Hintergrund. Vor allem 
das compilieren dauert etwas länger und geschieht im Hintergrund 
 
Anmerkung: Wenn Sie Dateien in Ihrem Projekt direkt im Windows Explorer ändern, löschen oder 
hinzufügen, dann können sie die Eclipse Projekt Ansicht mit dem Kontext Menü des Projektes 
aktualisieren. Wählen sie hierzu die Option „Refresh“. Sie sehen nun die neuen Dateien auch im Eclipse 
Projekt 
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Klicken Sie nun mit der rechten Maustaste auf den Projekt Knoten und wählen sie aus dem Kontextmenü 
Tomcat Project>Kontext in Tomcat aktualisieren. Damit wird das Projekt in die Konfigurationsdatei des 
Application Servers eingetragen. Die Eintragung muss nur beim ersten mal vorgenommen werden. 
 
Hintergrund: 
Das Projekt wird in die zentral server.xml Konfigurationsdatei des Tomcat Application Server als 
<context> eingetragen. Ein <context> entspricht dabei einer Web Anwendung 
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Geänderte Tomcat Konfigurationsdatei server.xml 
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Wechseln Sie nun wieder in die Debug Ansicht und starten Sie den Tomcat Application Server über die 
Toolbar. 
 
Anmerkung: Wenn sie im Log mehrere Fehlermeldungen der Form  
java.sql.SQLException: Table already exists: [Tabellenname] Sehen, dann können Sie diese einfach 
ignorieren. Die Demo Anwendung versucht hier eine kleine In Memory Datenbank mit SQL Scripten 
einzuspielen. Die Datenbank existiert aber eventuell schon, da sie zwischen den Programm Starts in einem 
Binär Stream persistiert wird. Die Datenbank Tabellen sind daher eventuell beim Programm Start bereits 
vorhanden und die SQL Scripten erzeugen diesen Fehler. 
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Im Console Fenster sollten Sie nun die folgende Ausgabe sehen: 
 
04.09.2005 13:46:45 [main] DEBUG FrontController - Initializing the application configuration 
04.09.2005 13:46:47 [main] DEBUG Database - executing database script: C:\Documents and Settings\Administrator\workspace\cc-
samples\web\WEB-INF\database\appointment.sql 
04.09.2005 13:46:47 [main] DEBUG Database - executing database script: C:\Documents and Settings\Administrator\workspace\cc-
samples\web\WEB-INF\database\article.sql 
04.09.2005 13:46:47 [main] DEBUG Database - executing database script: C:\Documents and Settings\Administrator\workspace\cc-
samples\web\WEB-INF\database\book.sql 
04.09.2005 13:46:47 [main] DEBUG Database - executing database script: C:\Documents and Settings\Administrator\workspace\cc-
samples\web\WEB-INF\database\city.sql 
04.09.2005 13:46:47 [main] DEBUG Database - executing database script: C:\Documents and Settings\Administrator\workspace\cc-
samples\web\WEB-INF\database\currency.sql 
04.09.2005 13:46:47 [main] DEBUG Database - executing database script: C:\Documents and Settings\Administrator\workspace\cc-
samples\web\WEB-INF\database\user.sql 
04.09.2005 13:46:47 [main] DEBUG FrameworkAdapterFactory - registering framework adapter: 
com.cc.sample.service.servlet.AppStrutsFrameworkAdapter@1ac13d7 
04.09.2005 13:46:47 [main] INFO  FrontController -  
 
* Version Information ************************************************ 
Product Name.........: common-controls-samples-ext 
Product Version......: 1.5.045 
Product Build Date...: Mon Jul 18 12:04:13 CEST 2005 
Product Vendor.......: SCC Informationssysteme GmbH 
Product Vendor-Site..: www.scc-gmbh.com 
Product Type.........: Production System 
********************************************************************** 
 
04.09.2005 13:46:47 [main] INFO  FrontController -  
 
* System Properties ************************************************** 
awt.toolkit..................................: sun.awt.windows.WToolkit 
catalina.base................................: C:\Program Files\Apache Software Foundation\Tomcat 5.5 
catalina.home................................: C:\Program Files\Apache Software Foundation\Tomcat 5.5 
catalina.useNaming...........................: true 
common.loader................................: 
${catalina.home}/common/classes,${catalina.home}/common/i18n/*.jar,${catalina.home}/common/endorsed/*.jar,${catalina.home}/com
mon/lib/*.jar 
file.encoding................................: Cp1252 
file.encoding.pkg............................: sun.io 
file.separator...............................: \ 
java.awt.graphicsenv.........................: sun.awt.Win32GraphicsEnvironment 
java.awt.printerjob..........................: sun.awt.windows.WPrinterJob 
java.class.path..............................: C:\Program Files\Apache Software Foundation\Tomcat 5.5\bin\bootstrap.jar;C:\Program 
Files\Java\jdk1.5.0_04\lib\tools.jar 
java.class.version...........................: 49.0 
java.endorsed.dirs...........................: C:\Program Files\Apache Software Foundation\Tomcat 5.5\common\endorsed 
java.ext.dirs................................: C:\Program Files\Java\jdk1.5.0_04\jre\lib\ext 
java.home....................................: C:\Program Files\Java\jdk1.5.0_04\jre 
java.io.tmpdir...............................: C:\Program Files\Apache Software Foundation\Tomcat 5.5\temp 
java.library.path............................: C:\Program  
 
etc. 
 
Rufen Sie die Anwendung aus dem Internet Explorer mit http://localhost:8080/cc-samples auf: 
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Wählen Sie eine Hyperlink aus: 
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Beobachten Sie das Log im Console Fenster, während Sie durch die Anwendung klicken. Hier werden alle 
Debug Meldungen der Anwendung ausgegeben (Die Anwendung und Common-Controls selbst verwenden 
ein sowohl einfaches, als auch leistungsstarkes und konfigurierbares Logging System Log4j). 
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3 Debugging 
Wir wollen nun zur Demonstration eine Debug Breakpoint an einer zentralen Stelle in der Anwendung 
setzen um den Debug Modus von Eclipse im Zusammenspiel mit dem Tomcat Server zu zeigen: 
 
Wechseln Sie in die Java Ansicht und wählen Sie im Package Explorer die Java Datei 
cc-samples\source\com.cc.sample.dialog\CCAction.java aus. 
 
Machen Sie einen Doppelklick auf die Methode doPreExecute(). Machen Sie in Java Sourcecode Fenster 
einen Doppelklick vor der Zeile 84. Damit wird ein Debug Breakpoint -gekennzeichnet durch einen Punkt - 
gesetzt. 
 

 
 
Wenn Sie nun eine Aktion in der Anwendung ausführen, dann wechselt die Eclipse Umgebung automatisch 
in die Debug Ansicht und hält auf dem Breakpoint an. 
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Sie können nun im selektierten Thread schrittweise durch den Programmcode springen und die Variablen 
beobachten. 
Es ist sogar möglich die JSP Seiten zu debuggen. 
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4 JSP Compiler 
Die JSP Seiten werden von der JSP Engine des Tomcat beim ersten Aufruf  in Java Servlets umgewandelt 
(als Java Quellcode) und anschließend in Java class Files übersetzt (Ein JSP Container benötigt daher 
immer einen Java Compiler). 
Dies geschieht im Verzeichnis im cc-samples\work außerhalb der Kontrolle von Eclipse. Um die 
kompilierten Dateien in der Eclipse Umgebung zu sehen ist es  daher notwendig von Zeit zu Zeit im Projekt 
Kontext Menü die Option „Refresh“ auszuwählen um die Projekt Sicht mit dem Festplatten Verzeichnis zu 
synchronisieren.  
 


